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i-Tree is a cooperative initiative



i-Tree is a state-of-the-art, peer-reviewed software suite from the USDA Forest Service 
that provides urban and community forestry analysis and benefits assessment tools. The 
i-Tree tools help communities of all sizes to strengthen their urban forest management 
and advocacy efforts by quantifying the environmental services that trees provide and 
assessing the structure of the urban forest. 

i-Tree has been used by communities, non-profit organizations, consultants, volunteers, 
and students to report on the urban forest at all scales from individual trees to parcels, 
neighborhoods, cities, and entire states. By understanding the local, tangible ecosystem 
services that trees provide, i-Tree users can link urban forest management activities with 
environmental quality and community livability. Whether your interest is a single tree or an 
entire forest, i-Tree provides baseline data that you can use to demonstrate value and set 
priorities for more effective decision-making.

Developed by USDA Forest Service and numerous cooperators, i-Tree is in the public 
domain and available by request through the i-Tree website (www.itreetools.org). The Forest 
Service, Davey Tree Expert Company, the Arbor Day Foundation, Society of Municipal 
Arborists, the International Society of Arboriculture, and Casey Trees have entered into a 
cooperative partnership to further develop, disseminate, and provide technical support for 
the suite.

i-Tree Products

The i-Tree software suite v 5.0 includes the following urban forest analysis tools and utility 
programs.

i-Tree Eco provides a broad picture of the entire urban forest. It is designed to use field 
data from randomly located plots throughout a community along with local hourly air 
pollution and meteorological data to quantify urban forest structure, environmental effects, 
and value to communities.

i-Tree Streets focuses on the ecosystem services and structure of a municipality’s street 
tree population. It makes use of a sample or complete inventory to quantify and put a 
dollar value on the trees’ annual environmental and aesthetic benefits, including energy 
conservation, air quality improvement, carbon dioxide reduction, stormwater control, and 
property value increases. 

i-Tree Hydro is the first vegetation-specific urban hydrology model. It is designed to model 
the effects of changes in urban tree cover and impervious surfaces on hourly stream flows 
and water quality at the watershed level.

About i-Tree



i-Tree Vue allows you to make use of the freely available National Land Cover Database 
(NLCD) satellite-based imagery to assess your community’s land cover, including tree 
canopy, and some of the ecosystem services provided by your current urban forest. The 
effects of planting scenarios on future benefits can also be modeled. 

i-Tree Species Selector is a free-standing utility designed to help urban foresters select 
the most appropriate tree species based on environmental function and geographic area.

i-Tree Storm helps you to assess widespread community damage in a simple, credible, 
and efficient manner immediately after a severe storm. It is adaptable to various 
community types and sizes and provides information on the time and funds needed to 
mitigate storm damage.

i-Tree Design is a simple online tool that provides a platform for assessments of individual 
trees at the parcel level. This tool links to Google Maps and allows you to see how tree 
selection, tree size, and placement around your home effects energy use and other 
benefits. This tool is in the early stages of development; more sophisticated options will be 
available in future versions.

i-Tree Canopy offers a quick and easy way to produce a statistically valid estimate of land 
cover types (e.g., tree cover) using aerial images available in Google Maps. The data can 
be used by urban forest managers to estimate tree canopy cover, set canopy goals, and 
track success; and to estimate inputs for use in i-Tree Hydro and elsewhere where land 
cover data are needed.

Disclaimer

The use of trade, firm, or corporation names in this publication is solely for the information 
and convenience of the reader. Such use does not constitute an official endorsement or 
approval by the U.S. Department of Agriculture or the Forest Service of any product or 
service to the exclusion of others that may be suitable. The software distributed under the 
label “i-Tree Software Suite v. 5.0” is provided without warranty of any kind. Its use is 
governed by the End User License Agreement (EULA) to which the user agrees before 
installation.

Feedback

The i-Tree Development Team actively seeks feedback on any component of the project: 
the software suite itself, the manuals, or the process of development, dissemination, 
support, and refinement. Please send comments through any of the means listed on the 
i-Tree support page: http://www.itreetools.org/support/.



i-Tree

Components of the i-Tree software suite have been developed over the last few decades 
by the USDA Forest Service and numerous cooperators. Support for the development and 
release of i-Tree v. 5.0 has come from USDA Forest Service Research, State and Private 
Forestry, and their cooperators through the i-Tree Cooperative Partnership of Davey 
Tree Expert Company, the Arbor Day Foundation, Society of Municipal Arborists, the 
International Society of Arboriculture, and Casey Trees. 

i-Tree Vue

i-Tree Vue was conceived and developed by Alexis Ellis (USDA Forest Service Northern 
Research Station), Mike Binkley (the Davey Institute), and David J. Nowak (USDA Forest 
Service Northern Research Station). The manual was edited and designed by Kelaine 
Vargas.
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Introduction
i-Tree Vue is a free-standing application that allows you to make use of freely available 
National Land Cover Database (NLCD) satellite-based imagery to assess your community’s 
tree canopy and some of the ecosystem services provided by your urban forest. The effects 
of different planting scenarios on future ecosystem services can also be modeled.

i-Tree Vue offers users a number of ways to add value to the original NLCD data. You 
can delineate basic study area boundaries using Google Maps; adjust tree canopy and 
impervious cover estimates based on U.S. Forest Service research; update land cover pixel 
by pixel to capture changes that have taken place since the NLCD release date; and use 
Google Maps aerial imagery and map data to improve NLCD image interpretation.

The best way to gain an understanding of your community’s urban forest and lay the 
foundations for good stewardship is to gather real data in the field, including tree species, 
size, and health; i-Tree Eco and i-Tree Streets are applications to help you do that. 
However, sometimes a broad estimate of canopy and tree-related benefits is helpful, either 
as a first step towards greater understanding or because time and financial resources are 
limited. Vue was designed for just this situation.

i-Tree Vue offers the following advantages:

• It provides broad estimates of tree canopy and associated air pollution removal, 
carbon storage, and annual carbon sequestration for the contiguous United States. 

• It allows you to easily explore NLCD imagery and information.

• It provides broad estimates of land cover and impervious cover for a study area.

• No field data are required.

• No software training and no GIS skills are required to run it.

• Extensive urban forestry knowledge is not required.

• Results for many areas can be developed in less than an hour.

• Tree canopy and ecosystem services are presented spatially, so you can visualize 
how they vary across your community.

• Amounts and monetary values of ecosystem services are presented in easy to 
understand summaries.

• The effects of changes in canopy can be modeled. 

Vue does have limitations that should be kept in mind. These are related to the nature of 
the NLCD data (the land cover data are derived from 30-meter resolution satellite imagery 
and may be several years old) as well as the use of state and national averages for air 
pollution removal and carbon sequestration. These limitations are discussed in more detail 
in Appendix 1.
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About This Manual

This manual provides all of the information needed to use i-Tree Vue and learn more about 
your community’s urban forest. It is broken down into the following sections:

Exploring Vue: Familiarize yourself with Vue and NLCD data for Washington D.C. in 
just a few minutes. 

Section I: Getting Started. In this section, we describe how to gather free National 
Land Cover Data necessary to run Vue. It is easier than you might think!

Section II: Working with Vue. Here you can get a feel for the simple controls and how 
the software runs.

Section III: Ecosystem Services. In this section, we describe the analyses that 
estimate what your urban forest does for you and what its future potential is.

Section IV: Updating Land Cover Data. We demonstrate how to update your NLCD 
data to make use of better information from the US Forest Service and to reflect 
changes in your study area since the imagery was taken.

Appendix 1: Appendix 1 provides a detailed description of the limitations of i-Tree 
Vue, some technical notes, and information on how the underlying data were derived. 

Appendix 2: In Appendix 2, instructions are provided for advanced clipping of NLCD 
imagery with ArcGIS v9.x and v10.
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System Requirements

Minimum hardware:

• 1 GHz processor with 1 GB memory. 

• Optimized for 1024 x 768 display resolution or higher.

Minimum software: 

• Microsoft Windows XP SP3 or higher.

• Internet Explorer 7 or higher.

• Adobe Reader 9.0.

Installation

To install Vue:

1  Visit www.itreetools.org to download the software or insert the i-Tree Installation 
CD into your CD/DVD drive. 

2  Follow the on-screen instructions to run the itree_setup.exe file. This may take 
several minutes depending on which files need to be installed. 

3  Follow the Installation Wizard instructions to complete the installation (default 
location recommended). 

Exploring Vue with the Sample Project

 If you would like to begin exploring Vue’s capabilities in the context of Washington D.C., 
you can skip to Section II: Working with Vue and use the sample projects that are 
included. Otherwise, start with Section I to gather the NLCD maps you’ll need to analyze 
your own urban forest. 

Installation

Note: Be sure to visit www.itreetools.org for more information, newsletters, and user 
forum access. And remember to use the application’s Check for Updates function 
periodically so you have the latest version, as we constantly strive to improve i-Tree!

http://www.itreetools.org
http://www.itreetools.org
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Obtain NLCD Imagery

 You will need to download three images for your study area from the National Land Cover 
Database (NLCD): land cover, percent forest canopy, and percent impervious cover. The 
Multi-Resolution Land Characteristics Consortium (MRLC) is the agency responsible for 
creating and maintaining the NLCD. Their web-based viewer is your gateway to obtaining 
the necessary images. A review of their viewer instructions is highly recommended.

1  Go to www.mrlc.gov/finddata.php and click the link to the MRLC Consortium 
Viewer page.

2  Click MRLC Consortium Viewer. Set your web browser to allow pop-ups from the 
MRLC site in your pop-up blocker settings.

3  Use the Zoom tool on the left to focus the window tightly on your study area.

4  You can use the categories under the Display Tab, such as Places, Transportation, 
Boundaries, and Hydrography, to help clarify your boundaries. 

a  Click the triangle to the left of each category to expand the options and 
then check the boxes to show the information on the map.

5  Once you have focused on your study area, click the Download Tab on the right, 
click the triangle next to Land Cover, and select only these layers for the desired 
year:

NLCD 20xx Land Cover 

NLCD 20xx Forest Canopy

NLCD 20xx Impervious Surface

6  Use the rectangular Download Tool from the toolbar on the left to draw a box 
around your study area on the map. Extend beyond your study area a little bit.

7  In the pop-up window that appears, make sure all three images are listed because 
all three must be downloaded at the same time to ensure they have the exact 
same extents. 

Section I: Getting Started

Note when choosing year: Forest Canopy data are not available for 2006, but the 
2001 Forest Canopy data can be mixed with the 2006 data for the other layers. NLCD 
1992 data are not compatible with Vue. 

www.mrlc.gov/finddata.php
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a  For each layer, when you click the Download Button, a Save File window 
will appear. Depending on server demand, the wait between these two 
steps can be VERY long.

b  Click Save and navigate to the location where you want the downloaded 
files to be stored. Change their default names to Land_Cover, Tree_
Canopy, and Impervious as appropriate.

8  Unzip each compressed file at your preferred folder location. Make a note of 
this location as you will need this for Section II. Each unzipped folder includes a 
metadata file (in .html format) that provides all of the background information on 
the data.

Clipping NLCD Imagery to a Project Area

Because NLCD data download as rectangular images, like digital camera photos, you may 
want to carve out the specific boundaries of your project area. This will restrict the Vue 
analyses to the tree canopy within your exact study area. If you are familiar with GIS, this 
is the time to review Appendix 2, which explains how to precisely clip your NLCD data with 
ArcGIS. Otherwise, proceed to Section II where you will have the opportunity to employ 
Vue’s simple clipping function to draw your project boundaries using Google Maps. This 
function is best for small, uncomplicated areas.
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To begin working with Vue:

1  Click your computer’s Start menu > (All) Programs > i-Tree > Vue.

2  The Browse for NLCD Imagery window will appear. 

3  Click the Browse buttons for the land cover, tree canopy, and impervious cover 
images and navigate to the folder locations where you unzipped each file. These 
would be the original, rectangular NLCD images (or, if you followed the procedures 
in Appendix 2, your GIS-clipped images).

4  Once all three images have been loaded, select the correct state from the Set 
Default Pollution Removal Values drop-down menu at the bottom. This will load 
default pollution removal values associated with trees for your state . 

5  If you want to want to define a specific area of interest on unclipped NLCD imagery, 
check the box next to Manually Define an Area of Interest. Keep in mind that 
this option is only for unclipped imagery; if you used GIS to clip your images, you 
should not use this function.

6  Click OK.

Section II: Working With Vue

Note: If you’re interested in exploring the sample imagery, click Explore 
Sample Imagery in the bottom right corner. In the pop-up box that appears, 
you have two options: working with unclipped imagery or working with clipped 
imagery.

1  If you choose the first option of working with unclipped imagery, you can 
begin following the instructions below under Defining an Area of Interest 
on NLCD Imagery.

2  If you choose the second option of working with data that has 
already been clipped to the project area, you can begin following the 
instructions below under Getting to Know the Vue Environment. 

Note: If your community has conducted an i-Tree Eco project, you can use the 
results of that project instead of the defaults. To do so, select i-Tree Eco project 
from the drop-down list. In the window that opens navigate to the place where 
you saved your project and click Open.
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7  If you chose to define an area of interest, a new window will open for editing. If you 
chose not to define an area of interest, image processing will begin. It may take 
some time to process the images and calculate their statistics. 

Defining an Area of Interest on NLCD Imagery (optional)

If you chose to define a specific area of interest (AOI) in the imagery in the steps above, 
the Define AOI on NLCD Imagery window will open. Your NLCD downloaded imagery is 
on the right and Google Maps with your image outlined in red is on the left. In this step you 
will draw an outline of your area of interest on the Google Maps and then transfer that 
outline to the NLCD imagery, refine the edges, and then “clip” and save the new NLCD 
images.

1  The first step is to draw an outline around your area of interest on the Google 
Maps.

a  Pan and Zoom the Google Maps view as needed. Switch between the Map 
and Satellite views to assist with refinement of your study area.

b  To begin defining your area of interest, click the Draw AOI Footprint button 
and click points around your study area on the Google map. Draw your 
boundary lines well outside of your area of interest to accommodate the fact 
that the imagery is composed of 30 m pixels.

c  You can drag the Google Maps markers to adjust the boundaries and you 
can also click to delete individual markers. Click the Start Over button if 
needed.

2  Once you are satisfied with the outline, click the Draw AOI on NLCD button to 
transfer the Google Maps boundaries to the NLCD imagery window. Note that 
this window is governed by a different set of map tools; hover over each for a 
description.

a  Toggle through the three images using the Toggle NLCD Images button 
to be sure that you have captured your area of interest. Pan and Zoom as 
necessary.

b  Next click AutoClip to erase most of the NLCD pixels outside of the 
boundaries. This may take a few moments.

c  AutoClip cannot get everything, so you can remove individual pixels from 
the edges and interior of your area of interest by clicking the TouchUp 
Eraser button and then clicking pixels to be removed. Use Zoom and Pan 
for precision work.
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d  Click Save and navigate to the folder where you want to store the clipped 
images. For each image, edit the name as desired, and click Save.

3  When you are finished, click OK and Vue processing will begin. It may take some 
time to process the images and calculate their statistics.

Getting to Know the Vue Layout

Viewports

The NLCD images appear in the upper left, upper right, and lower left corners of the 
window. Each image can be maximized by clicking the Maximize button in its top right 
corner. The lower right corner is reserved for the analysis outputs. 

Statistics panel 

Tabbed pages of statistics are presented along the right side of the Vue window. The 
General tab presents tree canopy and impervious cover (in acres and percent) across 
your study area. A more detailed look at the five general land cover categories is 
presented on the subsequent tabs. The Pixel Info tab enables you to get a closer look 
at the composition of individual 30 x 30 m pixels. The Classes tab provides descriptions 
of the NLCD land cover classes. The About tab provides links to more information about 
Vue, and the Help tab provides instructions for using the main Vue window.

Image tools

The tools at the bottom left provide basic control of the images through common Zoom 
and Pan functions, including zoom to Full Extent and 1:1 zoom tools. Legends for the 
images can be toggled on and off as well. You can Measure straight distances down to the 
resolution of the image data (~100 ft/30 m). The Print button yields a simple layout of the 
four images. The NLCD Statistics Report displays statistics about your study area while 
the NLCD Analysis Report next to it displays statistics about your analyses, once run. 
Hover over the tools for their names.

Interactive Google tools 

GoogleFind and GoogleVue help users interpret the NLCD data. GoogleFind lets 
you click a point on any of the four images to find that location on Google Maps in a 
separate pop-up window. Clicking on the resulting Google Maps marker will display 
more information about the location. GoogleVue allows you to view a translucent overlay 
of the NLCD imagery on top of Google Maps by clicking a point on any of the four 
images. Depending which of the NLCD images you click on, an 11 x 11-pixel set of land, 
tree, impervious cover or analysis data will be generated over the selected point. This 
feature allows you to view and compare NLCD imagery with more recent Google Maps 
images. When GoogleVue is showing NLCD land cover data, right-clicking on a pixel will 
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display the NLCD class. When legends are turned on in Vue, they will also appear in the 
GoogleVue map.

Both tools remain active once clicked. There is some limited zoom and pan interaction 
between the NLCD imagery and the Google Maps window. The Google Maps window 
can be “docked” over any of the four viewports with the UL, UR, LL, LR buttons (upper 
and lower right and left). Undock returns it to a free-floating window and “X” will close it. A 
high-speed internet connection is needed to use both tools. 

Units

The Units button allows you to toggle between U.S. and metric units.

Analysis options

Use the Analysis Options button to access the urban forestry analysis switchboard. 
These analyses are the core elements of i-Tree Vue. Each analysis offers reports and a 
corresponding visualization in the main Vue window for a number of ecosystem services. 
In addition there are several options for exploring different canopy cover scenarios. 
Detailed help is provided on the right side of each screen and in the manual below. The 
analyses can be divided into five types, which will be described in depth in the next 
section: Carbon Removal, Pollution Removal, NLCD Cover Adjustments, Existing 
Urban Forest Structure, and Canopy Scenario Modeling. 

Finally, the Analysis Options include the opportunity to fine-tune the NLCD data based on 
existing conditions under the NLCD Cover Adjustments. 
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The ecosystem services analyses that are accessed under the Analysis Options button 
are the core of Vue. Annual Carbon Removal and Pollution Removal are analyzed and 
results are provided in terms of tons removed and the equivalent dollar value for the tree 
canopy in your study area. The Existing Forest Structure analyses describe the amount 
of available planting space and the existing canopy cover. Canopy Scenario Modeling 
provides a method to experiment with the effects of a gain (or loss) of canopy for your 
study area, along with related changes in carbon and pollution removal.

Most results are provided for the entirety of your study area as well as broken down by 
land cover type. Defaults for the amount of carbon or pollution removed per acre and 
associated monetary values are based on national and state averages (or your i-Tree Eco 
project). For example, carbon storage on a per acre basis is estimated using a national 
average of 9.1 kg C/m2 or 81,188.3 lbs C/acre and a monetary value of $20.68/ton. Keep 
in mind that, for each analysis, the results refer to the benefits derived from the trees. For 
example, when carbon storage is reported for the agricultural land cover class, this refers 
only to the carbon storage of trees within that land cover class, not to the total carbon 
stored in soil, crops, etc. 

Carbon and Pollution Removal

The Total Carbon Storage analysis estimates the total tons of carbon (also presented in 
terms of tons of CO2 equivalents) that are currently stored in your study area’s trees.

The Annual Carbon Sequestration analysis estimates the total tons of carbon (also 
presented in terms of tons of CO2 equivalents) removed from the atmosphere each year 
by the trees of your study area. 

Analyses of the estimated amounts of pollution removed by the trees are provided for 
Carbon Monoxide (CO), Nitrogen Dioxide (NO2), Ozone (O3), Sulfur Dioxide (SO2), 
and Particulate Matter, less than 10 microns (PM10 ).

To begin these analyses and view the results:

1  From the main i-Tree Vue window, click the Analysis Options button. 

2  On the subsequent analysis switchboard, choose one of the Carbon Removal or 
Pollution Removal analyses and click OK.

Section III: Ecosystem Services

Note: Vue allows for you to make a number of changes to the basic NLCD data to 
yield more accurate results. These procedures are outlined in Section IV.



11 

3  The input window that appears presents the default national (carbon) or state 
(pollution) averages for your study area. If you have better local information, you 
can enter it here.

4  Click OK and allow time for Vue to process the information. This is done pixel by 
pixel and may take a few minutes.

5  Results are displayed in the Analysis Output viewport on the main Vue window. A 
statistics report also appears when the processing is complete. The report can be 
accessed from the image toolbar until the analysis is reset.

Existing Urban Forest Structure

The Available Green Space analysis estimates the amount of available planting space as 
the total area minus existing canopy cover minus impervious surface. 

Canopy Green Space presents total tree canopy in acres and percent for your study area.

1  From the main i-Tree Vue window, click the Analysis Options button. 

2  On the subsequent analysis switchboard, click Available Green Space or Canopy 
Green Space and click OK.

3  In the window that appears, check the land cover categories you would like to have 
analyzed.

4  Click OK and allow time for Vue to process the information. This is done pixel by 
pixel and may take a few minutes. 

5  Results are displayed in the Analysis Output viewport on the main Vue window. A 
statistics report also appears when the processing is complete. The report can be 
accessed from the image toolbar until the analysis is reset.

Canopy Scenario Modeling

One very valuable function of Vue is the ability to model the effects of changes in canopy 
cover on environmental benefits. There are four options to explore the effects of increasing 
or decreasing canopy cover: 

Across the entire region: This option adjusts the percent canopy cover evenly across 
the study area.

Broken down by the five general NLCD classes: This option allows you to adjust 
canopy changes for each of the broad land cover categories independently.
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Across the aggregate of all developed NLCD areas: With this option, you can 
change the percent canopy cover equally for all developed areas while leaving canopy 
levels in other land cover types untouched.

Broken down by the four developed NLCD sub-classes: This option allows you to 
adjust canopy cover levels in developed areas of different intensities independently. A 
very dense urban core, for example, may have a lower canopy target than suburban 
areas. In this option all undeveloped areas are held constant.

To adjust canopy levels:

1  On the main i-Tree Vue window, click the Analysis Options button. 

2  On the subsequent analysis switchboard, choose one of the modeling scenarios 
and click OK.

3  In the window that appears, your existing levels of canopy cover are shown, 
together with the maximum available planting space (defined as areas without 
existing trees and without impervious cover). 

a  For each land cover, enter the desired level of canopy cover to be modeled. 
The Maximum Possible Tree Canopy cannot be exceeded, and for values 
below the Existing Tree Canopy, a loss in tree cover will be modeled.

b  If you wish to edit the default per-acre values or monetary amounts for 
any of the ecosystem services, check the box next to each service. The 
appropriate fields will appear for editing.

4  Click OK and allow time for Vue to process the information. This is done pixel by 
pixel and may take a few minutes. 

5  Results are displayed in the Analysis Output viewport on the main Vue window. A 
statistics report also appears when the processing is complete. The report can be 
accessed from the image toolbar until the analysis is reset.

Reporting Options

For all the Analysis Options, output processing time is dependent on system resources and 
NLCD image size. On slower machines, processing may take several minutes. The 
processing activity is shown by a progress bar at the bottom of the screen. Occasionally, 
progress will appear to stall due to other system activity on your computer. You should NOT 
exit the program at this point. Instead, wait a few more minutes for the processing to finish.

Viewing

Once processing has completed, the Analysis Output image will appear in the bottom 
right viewport of the main Vue window and the NLCD Analysis Report will appear in a 
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pop-up window. An Executive Summary table and Full Report of the analysis results are 
provided. Click the plus signs to open new levels or click Expand All to view everything 
in a given report at once.The output image is used to visualize trends across the study 
area and can be examined in detail with the Pixel Info tab on the Statistics Panel. 

Printing

The four images can be printed together as they appear in the current view along with their 
respective legends. Click the Print button in the image toolbar for this option. Then click 
the Print button on the resulting Print Preview window. 

For the reports, a Print button is available at the bottom of the report. The reports will be 
printed in the state in which they appear on the screen—with the various levels expanded 
or collapsed.

Saving

To save the analysis output image file and the corresponding NLCD images, click the 
Save Output button at the bottom right of the main window. Navigate to the desired 
location, give the file a name and click Save. A .tif file with the image and a .tfw worldfile 
for use in GIS programs will be saved. 

The reports can be saved as comma-delimited text files (.csv) by using the Save button 
at the bottom of the report. Microsoft Excel can be used to open the Executive Summary 
comma-delimited file for further editing and formatting.
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Section IV: Updating Land Cover Data

There are a couple of limitations inherent in the NLCD data. First, it has been determined 
that NLCD data underestimates both canopy cover and impervious cover (see Appendix 1 
for more on these issues.) Second, because it takes years to develop the NLCD image 
products, your study area may have experienced significant changes in the meantime. 
Finally, because of the coarse nature of the 30 x 30 m pixels, the amount of tree canopy 
or impervious cover can be incorrect. Small trees or small areas of pavement can be 
“washed out” by surrounding land cover in a given pixel. These limitations are inherent 
in this kind of imagery—which we should remember is both free and computationally 
manageable.

In response to the first of these limitations, the U.S. Forest Service (USFS) undertook a 
sampling campaign to identify regional underestimation of canopy and impervious cover 
using aerial photography interpretation techniques. These revised regional values can 
be entered in Vue to improve results. Alternatively, you might consider using the i-Tree 
Canopy program to generate a statistical estimate of your current tree canopy percentage. 
The difference between the i-Tree Canopy percentage and the NLCD value presented by 
i-Tree Vue is your correction factor and can be entered into Vue.

To address the second and third limitations, a new function in Vue allows you to update 
individual pixels for land cover, tree canopy, and impervious cover over small areas using 
Google Maps. 

Adjusting Canopy Levels and Impervious Cover Evenly Across your Study Area 

To make changes to the default NLCD information for tree canopy and impervious cover 
evenly across your study area: 

1  On the main i-Tree Vue window, click the Analysis Options button. 

2  On the subsequent analysis switchboard, click Tree Canopy or Impervious Cover 
and click OK.

3  Both analysis forms present a map of USFS research zones for the contiguous 
United States and a list of their adjustment values. 

a  Zoom and Pan the map to find the zone that contains the bulk of your study 
area.

b  When you’ve identified your zone, click the adjustment factor for that zone 
from the list below the map. It is labeled “Difference”. The appropriate value 
will appear in the box above.
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4  Alternatively, to use a correction factor based on an i-Tree Canopy survey, type 
in the difference between the i-Tree Canopy tree canopy percentage and the tree 
canopy percentage reported by i-Tree Vue for the entire study area directly in the 
box above.

5  Click OK. The changes will be made pixel by pixel and may take a few minutes to 
process.  

Adjusting Land Cover Classification Pixel by Pixel

The instructions below describe how to make changes to three aspects of the data 
included in every pixel: (1) the land cover classification (e.g., high density developed, 
mixed forest, water, etc.), (2) the average percent tree canopy over that pixel, and (3) the 
average percent impervious cover over that pixel. 

Consider, for example, an area that was heavily forested at the time the NLCD images 
were created and has since been developed as a suburban neighborhood. According to 
the NLCD data, a pixel in the midst of this area might appear as “Forest, deciduous” with 
a tree canopy cover of 100% and impervious cover of 0%. Its current condition, however, 
may be more accurately described as “developed, low intensity”, with a tree canopy cover 
of 30%, and an impervious cover of 20%.  

The instructions below describe how to make changes to these three aspects of the data. 
A high speed internet connection is required.

1  On the main i-Tree Vue window, zoom and pan the NLCD imagery to the desired 
location.

2  Click the Analysis Options button. 

3  On the subsequent analysis switchboard, select Land Cover and click OK. A 
Google Maps Pixel Navigator window will appear.

4  Within the Navigator, zoom and pan further to the area to be updated.

5  Click the Fetch Land Cover Pixel Subset button. The NLCD land cover 
classification pixels will appear over the Navigator map. You can scroll over the 
pixels and, in the bottom right of the map area, the land cover classification, tree 
canopy (TC) and impervious cover (IC) will appear. 

6  To change an individual pixel to a new land cover, tree canopy, and/or impervious 
cover:

a  If you want to change the land cover classification, select the new land 
cover type below the map. 
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b  If you want to change the level of tree canopy, check the edit box next Tree 
Canopy and move the slider bar to the correct level.

c  If you want to change the level of tree canopy, check the edit box next 
Impervious Cover and move the slider bar to the correct level.

d  Then right-click the appropriate pixel in the map to change these three 
aspects of the data at the same time. 

e  Do not click too fast as this method relies on cross-communication between 
Vue and Google Maps.

f  The new values will appear at the bottom right under Current values when 
you mouse over the pixels.

g  To get a better look at the details of the Google Maps underneath, you can 
click Hide Land Cover Pixels. Click Show Land Cover Pixels to work with 
them again.

7  Click the Advanced button below the Help panel to see what your changes will 
look like on the NLCD images. You may need to Zoom and Pan these images to 
find your editing area.  

8  After editing various pixels, periodically click the Commit Changes button to save 
your updated images. 

9  The entire process—steps 4 through 8—can be repeated as many times as 
necessary.

10  Click OK when you are completely done editing pixels. Your edited images will be 
loaded into Vue.

When you’re satisfied with the adjustments you’ve made to the default data, you can 
return to Section III and continue to analyze and view results on your improved NLCD 
data.
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Appendix 1: Limitation and Data Notes

Limitations

 i-Tree Vue provides broad estimates of tree canopy cover and some urban forest 
ecosystem services without requiring users to collect field data. Without field data 
collection, the estimates can only be considered very coarse approximations with some 
significant limitations on the data and estimates. 

Despite these limitations, i-Tree Vue is designed to provide easy first-order approximations 
of ecosystem services for urban areas. These data be can used to view differences in 
existing cover and services, potential changes in benefits with changes in tree cover, and 
to provide a stepping stone to more accurate estimates of services through i-Tree Eco or 
i-Tree Streets. These data should not be considered final or accurate estimates of urban 
tree cover or environmental services.

Generalized estimates

The basic approach to i-Tree Vue is to use spatial forest canopy maps developed for 
the National Land Cover Database (NLCD) (http://www.mrlc.gov) and apply average 
ecosystem service values per unit of canopy cover to estimate services of the local area. 
This generalized approach using national and state averages has significant limitations at 
the local scale.

NLCD tree cover estimates

NLCD provides tree cover estimates with 30-meter pixel resolution for the contiguous 
United States. This national database provides important information on our national tree 
resources, but has limitations, particularly at the local scale. Tree cover estimates from the 
NLCD cover maps have been shown to underestimate tree cover by an average of about 
10% (Nowak and Greenfield 2010) across the nation and by as much as 28%. Similarly, 
estimates of impervious surface have been shown to be underestimated by an average 
of 1.4% and by as much as 6%. Vue offers functionality that allows you to make a coarse 
adjustment to the canopy and impervious cover of your area based on the work by Nowak 
and Greenfield (2010). 

Air pollution removal estimates

To more accurately estimate pollution removal in a city, local pollution and weather data 
are needed, as well as local estimates of the leaf area index (depth of canopy) and canopy 
cover. As local data are unknown in i-Tree Vue (except for the estimate of tree cover), 
i-Tree Vue uses state average estimates of annual pollution removal per square meter 
of tree cover (g/m2/yr) to estimate local pollution removal assuming a leaf area index of 
6 [i.e., 6 m2 of leaves (one-sided) per m2 of canopy cover]. As pollution concentrations, 
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weather, and urban forest leaf area indices can differ significantly at the local level, i-Tree 
Vue estimates are coarse at best. The closer your area conditions are to the state average 
and a leaf area index of 6, the closer the i-Tree Vue estimates will be for your area. Better 
estimates can be obtained by collecting local field data and using i-Tree Eco or i-Tree 
Streets. More information is given below on how air pollution removal was calculated.

Carbon storage and sequestration estimates 

To more accurately estimate carbon storage (amount of carbon currently in trees) and 
annual carbon sequestration (amount of carbon removed in one year) in a city, local 
environmental conditions (e.g., tree competition, length of growing season) and tree 
density, species, and diameter distribution information are required. As local tree data are 
unknown in i-Tree Vue (except for the estimate of tree cover), i-Tree Vue uses national 
average estimates to approximate local carbon effects. Carbon sequestration and 
storage values are estimated from tree cover (m2) multiplied by average carbon storage 
(9.1 kg C/m2), and sequestration (0.3 kg C/m2) density values derived from several 
U.S. communities (e.g., Nowak and Crane 2002, Nowak and Greenfield 2008). As tree 
population and environmental variables can differ significantly at the local level, i-Tree Vue 
estimates are coarse at best. The closer your area conditions are to the group average, 
the closer the i-Tree Vue estimates will be for your area. Better estimates can be obtained 
by collecting local field data and using i-Tree Eco or i-Tree Streets.

Dollar value estimates

Monetary estimates of ecosystem services are based on literature estimates of values 
per ton of pollution or carbon. Monetary values associated with urban tree carbon storage 
and sequestration were based on the 2001–2010 projected marginal social cost of carbon 
dioxide emissions, $22.8/t C (Fankhauser 1994). Pollution-removal dollar value estimates 
were calculated using 1994 national median externality values used in energy decision 
making (Murray et al. 1994, Ottinger et al. 1990). The 1994 values were adjusted to 2007 
dollars based on the producer price index (U.S. Dept. of Labor 2008). These values, in 
dollars/metric ton (t) are as follows: nitrogen dioxide (NO2) = $9,906/t, particulate matter 
less than 10 microns (PM10) = $6,614/t, sulfur dioxide (SO2) = $2,425/t, carbon monoxide 
(CO) = $1,407/t. Externality values for ozone (O3) were set to equal the value for NO2. 
Externality values can be considered as the estimated cost of pollution to society that is 
not accounted for in the market price of the goods or services that produced the pollution.

Methods for Estimating Air Pollution Removal

 Air pollution removal estimates were derived from the Urban Forest Effects (UFORE) 
model (Nowak and Crane 2000) and 2000 weather and pollution data (National Climatic 
Data Center 2000, U.S. EPA 2008). The UFORE model was used to integrate hourly 
pollution and weather data with urban or community tree cover data to estimate annual 
pollution removal in each state (Nowak and Crane 2000, Nowak et al. 2006). 
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To estimate pollution by urban trees in each state, state pollutant flux rates (grams of 
pollution removal per square meter of canopy per year) were derived from a study of 
national pollution removal by urban trees for the year 1994 (Nowak et al. 2006). As 
pollution concentrations vary through time, the 1994 flux rates were adjusted to 2000 
values based on average regional pollution concentration changes between 1994 and 
2000 (U.S. EPA 2003). As flux rate = deposition velocity * pollution concentration, the ratio 
of the pollution concentration between years was used to update the flux rate. 

Arithmetic mean concentration values were used for nitrogen dioxide, particulate matter 
less than 10 microns, and sulfur dioxide; 2nd max. 8-hr average for carbon dioxide; and 
4th max. 8-hr average for ozone, to determine the ratio of change between 1994 and 2000 
(U.S. EPA 2003). The new 2000 flux rates are multiplied by urban or community tree cover 
to estimate total pollution removal by trees.

NLCD Imagery Technical Notes

Learn more

Visit the Multi-Resolution Land Characteristics Consortium (MRLC) website (www.mrlc.
gov) to learn about their mission and the NCLD data used in i-Tree Vue. In particular, 
review the NLCD factsheet available right under their FAQ section.

Rounding

NLCD image data are stored as values from 0 to 100 in each image pixel. As such, results 
of the new tree canopy estimates are necessarily rounded. This rounding has the potential 
to skew user-defined tree cover estimates in the output tree canopy data set by up to one 
percent. This skewing is more pronounced when dealing with a region or land cover that 
covers a very small area of interest. In addition, carbon and pollution values are not actually 
stored in the image pixels as rounding them would reduce their usefulness. Instead, tree 
canopy—existing or new estimates—are stored in the image pixels. Within i-Tree Vue, the 
carbon and pollution values are then computed on the fly for display in the pixel information 
windows. After export of carbon or pollution images, you can multiply the stored tree canopy 
values by your chosen carbon and pollution values in your GIS program. 

Projection system 

See www.mrlc.gov or the metadata files that came with the images for more information: 

Projection ALBERS 
Datum NAD83  
Spheroid GRS80  
Units METERS  
Zunits NO  
Xshift 0.0  
Yshift 0.0  

www.mrlc.gov
www.mrlc.gov
www.mrlc.gov
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Parameters  
29 30 0.0 /* 1st standard parallel  
45 30 0.0 /* 2nd standard parallel  
-96 0 0.0 /* central meridian  
23 0 0.0 /* latitude of projection’s origin  
0.0 /* false easting (meters)  
0.0 /* false northing (meters) 
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Appendix 2: Clipping NLCD Imagery  
with ArcGIS

Vue offers a simple function that allows you to clip the boundaries of the NLCD imagery 
to your study area, but if you have access to GIS, you may find it easier to perform the 
clipping using GIS’s greater functionality.

ArcGIS v. 9.3  & v. 10

ArcGIS v. 9.3 or v. 10 can be used to clip NLCD imagery and do not require any 
extensions. 

1  Load the three NLCD images into a new ArcMap project FIRST. This sets the 
projection system to that of the images; this is critical for proper functioning of Vue. 
Do NOT reproject the NLCD imagery as this will distort the image pixels and throw 
off all Vue calculations.

2  To extract the project area from each NLCD image, navigate to ArcToolBox > 
Data Management Tools > Raster > Raster Processing > Clip.

3  Fill out the Clip form as follows:

a  The Input Raster should be the impervious, tree canopy, or land cover 
images downloaded from MRLC website.

b  The Output Extent is the polygon boundary shapefile you wish to clip with.

c  Check the box next to Use Input Features for Clipping Geometry 
(optional).

d  For the Output Raster Dataset, browse to an appropriate location on your 
hard drive and name the Output Dataset with a .TIF extension: “your_layer_
name.tif”.  Note: TIF and TFW files will be created at the chosen output 
location.

e  NoData Value (optional) should be left blank.

4  Shut down ArcGIS when finished to release the clipped image files for use in Vue. 
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ArcGIS v. 9.2

Users with ArcGIS v. 9.2 will need to acquire the Spatial Analyst extension to perform the 
clipping.

1  To enable Spatial Analyst, in the main ArcMap menu, choose Tools > Extensions 
> Spatial Analyst.

2  Load the three NLCD images into a new ArcMap project FIRST. This sets the 
projection system to that of the images; this is critical for proper functioning of Vue. 
Do NOT reproject the NLCD imagery as this will distort the image pixels and throw 
off all Vue calculations.

3  To extract the project area from each NLCD image:

a  Navigate to ArcToolBox > Spatial Analysis Tools > Extraction > Extract 
by mask.

b  Set your project area-of-interest polygon map layer as the mask.

4  To export each of the three extracted datasets:

a  Right-click layer name > Data > Export Data.

b  Change the location for the exported data (remembering to only single click 
on the output folder location).

c  Change format to TIFF.

d  Adjust name as needed.

e  Leave other options at defaults.

5  Create a World File (*.TFW) for each of the three exported images by following this 
path: ArcToolBox > Data Management Tools > Raster > Raster Properties > 
Export Raster World File.

6  Shut down ArcGIS when finished to release the clipped image files for use in Vue. 
Note that Vue may initially display these images in grayscale, but will attempt to 
apply the proper color palette to each.
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